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Introduction & Motivation

Objective: overview of JANIS software and select features

' JANIS: Java-based Nuclear Information Software [1]
I Available for of ine (Java-based) and online (website-based) use

I Focus of this talk is on the of ine application
I Both approaches are cross platform

I Visualize and manipulate a variety of nuclear data

' Decay & ssion-yield data
I Interaction data: cross-sections, distributions, uncertainties

I Access a variety of libraries: EN(S)DF, JEFF, JENDL, TENDL, IRDF, etc.

I Why this talk?
I JANIS is cited in several MCNP classes

I Despite usefulness, awareness of JANIS is not pervasive
I Alternative to BNL NNDC, KAERI NDC, IAEA EXFOR, etc.

JANIS 4.0 includes log4j version 1.2.17, which is not affected by the vulnerability identi ed in 2021. Slide 3 of 22


https://www.nndc.bnl.gov
https://atom.kaeri.re.kr
https://www-nds.iaea.org/exfor/exfor.htm
https://logging.apache.org/log4j/2.x/security.html

Getting & Con guring JANIS

&nen

ABOUTUS TOPICS  NEWS AND RESOUF LEARNING AND

- Whatis JANIS? + Content of the NEA data
- screenshot + Help page:
+ Whats new in 4.1 (Sept 2020)

(® Launch JANIS 4.1 JANIS We
Jova Web start

e vrsion o
& Downloads
Softwae, Manus, OVD 40150

Available from: https://www.oecd-nea.org/jcms/pl_39910/janis.
Access downloads; choose “Software Only.” Slide 4 of 22
Note: a Google search for “janis” rst gives Janis Joplin hits; suggest searching for “janis oecd”


https://www.oecd-nea.org/jcms/pl_39910/janis

Getting & Con guring JANIS, cont.

(@}

I+

Extract the ZIP le
Bundle has caused problems recently with direct execution

I Navigate to extraction directory and execute janis.sh
I Effectively: java -Xms100M -Xmx512M -jar software/Janis.jar

Untested, but is expected to be the same as macOS
Navigate to extraction directory and execute janis.bat

Once launched, may need to set proxy via File menu Preferences dialog
I Use Network tab and Test Connectivity button

Databases

Look for the green checkmark—if present, one can proceed. Slide 5 of 22



Interaction Cross Sections: Total Fe-56 + Unc.

JANIS NEA - Incident neutron data - ENDF/B-VIILO - Cross sections.

File Database Search Chart
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Interaction Cross Sections: Total Fe-56 + Unc., cont.

NEA N ENDF/B-VIILO SIG Fe56

Tools _Selected _Help

Ploter
X Log 8 v Log

- Cross sections

Incident neutron data / ENDF/B-VIILO / Fe56 / MT=1 : (n,total) / Cross section + Std. deviation Xmin= 10 pev.

Xmax= 150 Mev
Ymin=  2.417604845 mb
Ymax=  632.940166667 b

More...

Incident energy (MeV)

Node Settings Display
NEA Incident neutron data / ENDF/B-VIILO / Cross sections / Fe56

General information
Resonances / Resonances data / Resolved parameters : 10 eV < £ < 850 keV.
MT=1: (n,tota)
3 Covariances data
3 Covariances data (BOXER)
Cross section
[ Cross section + Std. deviation
MT=2 : (z,elastic]
DIMT=4 )

Slide 7 of 22



Interaction Cross Sections: Total Fe-56 + Unc., cont.

NEA N ENDF/B-VIILO SIG Fe56
elected Help

L Cross sections _§§ Cross sections Tabler
15t column values

Incident neutron data / ENDF/B-VIILO / FeS6 / MT=1: (n,tota) / Cross section + Std. deviation el
nddenten.., o)
T sh03 6340843 interpolated values
L06256-5 217.1607 6157523
Li2ses 2110817 5985155
1187565 2054902 5826609
L2565 2003245 5680138 10 pev

1910732 541782

51891

150 Mev

More.

118750-4 701017 1 RSSSRY

Node Settings
NEA Incident neutron data / ENDF/B-VIILO / Cross sections / Fe56
£ General information

Display

10 peV < £ < 850 keV.

Resonances / Resonances data / Resolved parameters
MT=1: (n,tota)

3 Covariances data
3 Covariances data (BOXER)
Cross section
[ Cross section + Std. deviation
MT=2 : (z,elastic]
DIMT=4 )

Use the File menu Export entry to save the tabular data as a CSV or XML le. Slide 8 of 22



Plotting the Exported CSV via NumPy

#!/usr/bin/env python

Microscopic Total £ross Section + Unc., o [b]

import matplotlib.pyplot as plt

1070 10% 10 107 107 10° 102
Energy, £ [MeV]

import numpy as np

X, ¥, € = np.loadtxt("fe56 —mtl_xs _stdev.csv", skiprows=3, delimiter=";", unpack=True)

fig, ax = plt.subplots(figsize=(6.5, 6.5 / 1.62))

X [= 1e6

p = plt.plot(x, y, w=0.5)

plt.fill _between(x, y - e, y + e, alpha=0.25, color=p[-1].get —color())
plt.xscale("log")

plt.yscale("log")

plt.xlabel("Energy, $E$ [MeV]")

plt.ylabel(r"Microscopic Total Cross Section + Unc., $\sigma —{\mathrm{t}}$ [b]")
plt.grid(Is=":", color="#000000", alpha=0.25)
plt.savefig("fe56 _mtl_xs _stdev.png”, dpi=600, bbox _inches="tight")

Slide 9 of 22



Covariances via Correlation Matrix

NEA N ENDF/B-VIILO SIG Fe56
File Tools Selected Help

¥ Correlation Map Plotter
B v g

10 pev

Correlation

ooy imev ey oomer 10sv o0ev ey ey e owey toomew 150 Mev

10 pev
10Mev—{ 10mey 150 ey

1mev—{ ey More...

Liokev

100kev-

10kev

ey

100ev

wev-|

MAT 2631, MF 33, MT 1

Liomev

Correlation matrix MT 1/ MT 1
Tmev

Storage:

100 v 2 NI components
LB=5 (symetric)
LB=5 (symetric)

T T T y T T T
100pev omev  100mev 0ev 1000y Thev ey oMev  100mev

MAT 2631, MF 33, MT 1

Node Settings Display

NEA Incident neutron data / ENDF/B-VIILO / Cross sections / Fe56
3 General information
Resonances / Resonances data / Resolved parameters : 10 eV < £ < 850 keV.
MT=1: (ntota)

Covariances data

[ Correlation matrix MT 1 / MT 1
3 Covariances data (BOXER)

Cross section
® Cross section + d. deviation
[ MT=2 - 2 elastic)

An application for these data is shown in [2]. Slide 10 of 22



Fission Yields

JANIS NEA - Radioactive data - ENDF/B-VILO - Fission yields data
File Database _Search Chart

FISSION YIELDS e 0 10 6 6
EE @ parents No [ No [No |

@ Products 261 262
@ End of Chains Md Md | Md

. Stable o — =5
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o

@
EEEES ES
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o]

=

P
=

>

Radioactive data

e >0
ZH 3 T 8% 39 oY

£ ENDF/B-VL,
ENDF/B-VILO
ENDF/B-VIL1
ENDF/B-VILO
® Cross sections
® Energy distributions

> B
B 33 BN 3% JY 8% 8| 5| o
B

o

40 pixels b 14M of 455M
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Fission Yields, cont.

NEA Spont. ENDF/B-VIILO FY U238
File Tools Selected Help

¥ U238 Spontaneous cumul. FY Map Plotter

x
ENDF/B-VI11.0 U238 Spontaneous cumulative fission yields

Charge of product

®

Neutron number of product

Node
NEA | Radioactive data / ENDF/B-VILO / Fission yields data / U238
General information / MT=451 : (z,..) Heading or tte information
sion data

Settings Display

> I parent cumulative fssion yields / Spontaneous

5 Parent independent fission yields / Spontaneous

Cumulative ssion yield: production directly from ssion or by decay of other nuclides. Slide 12 of 22



Fission Yields, cont.

NEA Spont. ENDF/B-VIILO FY U238
File Tools Selected Help

4 U238 Spontaneous cumul. FY 3 Fission yields Tabler

1st column values

Radioactive data / ENDF/B-VIIl.0 / U238 / Fission data / Parent cumulative fission yields Spontaneous el Vel
duct Vield Error

interpolated values

2004e-14  1.61283e-14
1002e-14  7.10811e-15

3.17445¢-13
4.87688e-13
5.37609e-13
31104513
1.26722¢-13
419007e-14  2.68164e-14
o o

0

0
0 0
2.16387¢-19  1.38487¢-19
o o

5.12648¢-13
1.43362¢-12

459007e-14  2.93765e-14
o

o
L80515e-17  L1553e-17
8.86892¢-19
2.23508e-19
R120130-12 3 R5RSRe-12

Settings Display
NEA | Radioactive data / ENDF/B-VILO / Fission yields data / U238

General information / MT=451 : (z,..) Heading or tte information

Fision data
> I parent cumulative fssion yields / Spontaneous

5 Parent independent fission yields / Spontaneous

Slide 13 of 22



Radioactive Decay

0
File Database Search Chart

JANIS NEA - - ENDF/B-VIILO -

BRANCHING 58 59
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Radioactive Decay, cont.

NEA Spont. ENDF/B-VIIL.O RDD Mo99
File Tools Selected Help

Decay Path
Layout
axes:  Compact X=Z-N, Y=Z)

zo0m
ENDF/B-VILO Mo99 decay path spacing
Nuclides

style: Circle

labels: Symbol over A
colors: _ Half-life (continuous)

Arrows

labels:  Decay, Branching
colors:  Decay mode
widths:  Cumulative branching

Hide branching below: (%)

0 193102 01 05 1

More.

Node

Settings Dispiay
NEA / Radioactve data / ENDF/B-VILO / Radioactive decay data / Mo99

Generalinformation / MT=451 : (z,..) Heading or tite information
Decay data
5 Beta-

Decay general data

Discrete Electron
Discrete Gamma
Discrete X-Rays

Slide 15 of 22



Radioactive Decay, cont.

NEA Spont. ENDF/B-VIIL.O RDD Mo99
File Tools Selected Help

M09 Mo99 decay path

Radioactive data / ENDF/B-VIIl.0 / Mo99 / Decay data / Decay path

v pa et Hal-Life Half-Lie error Branching error

Teoom 00 88641% 0.2302841%

Te9 2375 02302841 %

Tc99 0.0006 % Isomeric transition
18 0.0006 % Beta-

6.66181E+125 3.78691E+10 100% Beta-

Node Settings Display
NEA / Radioactve data / ENDF/B-VILO / Radioactive decay data / Mo99

Generalinformation / MT=451 : (z,..) Heading or tite information
Decay data
5 Beta-

Decay general data

Discrete Electron
Discrete Gamma
Discrete X-Rays

Slide 16 of 22



“Weighting”: BUGLE-B7 vs. HELIOS [4, 5]

Weighting
Selection ~ Group  Spectrum
Node Selected
NEA N ENDF/B-VIILO SIG Fe56 NEA / Incident neutron data / ENU

File Tools Selected Help (n.tota))

@elastio)
£ Cross sections
@m
 (ntotal) 59 MT=5 - (2 anything)
B MT=16: (2,200
e 7 roup, W spectrum Weghted Cross MT=51: (2,n'1) / Cross sectio

T Welghting - bug 47 aroup, PWR spectrum Welghted Cros|
Cross section + St deviation

Incident neutron data / ENDF/B-VIILO / Fe56 / MT=

Cancel

Selection  Group  Spectrum
Groupty... File defin... §
Choose af...

is_group_structure_bugle-b7_47g.gst | Browse.

Cancel

Incident energy (MeV)

Setings 3 Weighting
8 Couriances data BOXER)

Cross section

Selection  Group  Spectrum
@ Cross section + Std. deviation

Spectrum ty... | PWR spectrum ()

Welghing : bug 47 group, PWR specirum

Spectrum

Weighted Cross section + Std. deviation Emaxth: 0.108 in.. Thetath: 0.054
Welghiing :hel 47 group, PWR spectrum

Spectrum Emax.ep... 2100000.0  in.. Thetafi.. 1400000.0

Welghted Cross section + Std. deviation
DIMT=2 : z,elastic

Cancel

Available from the Tools menu Weighting e
Other group structure les are available from the JANIS dow
Weighting spectrum details available in [3].


https://www.oecd-nea.org/janis/janis-4.0/software/groups.zip

Querying Multiple Libraries

N
<7 . g

P
Ve
A

Available from the Tools menu Searches/ENDF entry. Slide 18 of 22



Querying Multiple Libraries, cont.

Select the newly available plots and style as desired. Slide 19 of 22



Evaluation vs. Experiment

P B
. g
a

Available from the Tools menu Searches/EXFOR entry. Slide 20 of 22



Evaluation vs. Experiment, cont.

Select the newly available plots and style as desired. Slide 21 of 22
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JANIS Group Structure File: BUGLE-B7 [4]

neutron group structure......bug 47 group

a7
46
45
a4
43
42
41
40
39
38
37
36
35
34
33
32
31
30
29
28
27
26
25

1.0000E-05
1.0000E-01
4.1399E-01
8.7643E-01
1.8554E+00
5.0435E+00
1.0677E+01
3.7267E+01
1.0130E+02
2.1445E+02
4.5400E+02
1.5846E+03
3.3546E+03
7.1017E+03
1.5034E+04
2.1875E+04
2.4176E+04
2.6058E+04
3.1828E+04
4.0868E+04
6.7379E+04
1.1109E+05
1.8316E+05

1.0000E-01
4.1399E-01
8.7643E-01
1.8554E+00
5.0435E+00
1.0677E+01
3.7267E+01
1.0130E+02
2.1445E+02
4.5400E+02
1.5846E+03
3.3546E+03
7.1017E+03
1.5034E+04
2.1875E+04
2.4176E+04
2.6058E+04
3.1828E+04
4.0868E+04
6.7379E+04
1.1109E+05
1.8316E+05
2.9721E+05

PN WA OO N 0O

2.9721E+05
3.6883E+05
4.9787E+05
6.0810E+05
7.4274E+05
8.2085E+05
1.0026E+06
1.3534E+06
1.6530E+06
1.9205E+06
2.2313E+06
2.3457E+06
2.3652E+06
2.4660E+06
2.7253E+06
3.0119E+06
3.6788E+06
4.9658E+06
6.0653E+06
7.4082E+06
8.6071E+06
1.0000E+07
1.2214E+07
1.4191E+07

3.6883E+05
4.9787E+05
6.0810E+05
7.4274E+05
8.2085E+05
1.0026E+06
1.3534E+06
1.6530E+06
1.9205E+06
2.2313E+06
2.3457E+06
2.3652E+06
2.4660E+06
2.7253E+06
3.0119E+06
3.6788E+06
4.9658E+06
6.0653E+06
7.4082E+06
8.6071E+06
1.0000E+07
1.2214E+07
1.4191E+07
1.7332E+07
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JANIS Group Structure File: HELIOS [5]

neutron group structure......hel 47 group

a7
46
45
a4
43
42
41
40
39
38
37
36
35
34
33
32
31
30
29
28
27
26
25

0.000000E+00 1.239596E-02

1.239596E-02
3.061288E-02
4.275520E-02
5.692194E-02
8.196816E-02
1.115699E-01
1.457206E-01
1.844302E-01
2.705213E-01
3.576701E-01
5.032318E-01
6.250621E-01
7.820830E-01
9.099967E-01
9.710043E-01
1.013699E+00
1.072203E+00
1.125397E+00
1.166404E+00
1.235105E+00
1.457402E+00
1.855391E+00

3.061288E-02
4.275520E-02
5.692194E-02
8.196816E-02
1.115699E-01
1.457206E-01
1.844302E-01
2.705213E-01
3.576701E-01
5.032318E-01
6.250621E-01
7.820830E-01
9.099967E-01
9.710043E-01
1.013699E+00
1.072203E+00
1.125397E+00
1.166404E+00
1.235105E+00
1.457402E+00
1.855391E+00
2.382393E+00

PN WA OO N 0O

2.382393E+00
3.927903E+00
4.450897E+00
5.043477E+00
5.715008E+00
6.476017E+00
7.338215E+00
8.315287E+00
1.209903E+01
1.371000E+01
2.902291E+01
4.785117E+01
7.889325E+01
1.300704E+02
2.034700E+03
9.118801E+03
6.737900E+04
1.831601E+05
4.978702E+05
8.208500E+05
1.353400E+06
2.231299E+06
3.678800E+06
6.065300E+06

3.927903E+00
4.450897E+00
5.043477E+00
5.715008E+00
6.476017E+00
7.338215E+00
8.315287E+00
1.209903E+01
1.371000E+01
2.902291E+01
4.785117E+01
7.889325E+01
1.300704E+02
2.034700E+03
9.118801E+03
6.737900E+04
1.831601E+05
4.978702E+05
8.208500E+05
1.353400E+06
2.231299E+06
3.678800E+06
6.065300E+06
2.000000E+07
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